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Chapter 9 — Ad-Hoc Reporting

The B2Gnow ad-hoc reporting tool offers powerful functionality to build and run advanced
reports. Authorized users can access published “data models” that are compilations of all
relevant fields and parameters in the system for a variety of useful record types. You can

F SOL Server2o0s

Reporting Services

Reporting Services Report Builder 2.0.

Launching Ad-hoc Reporting

customize the included fields and formats plus
filter, sort, and layout the results.

The underlying technology is Microsoft SQL
Server 2008 Reporting Services and Report
Builder 2.0. This guide provides a summary
overview of accessing ad-hoc reporting and
creating a simple report. For more advanced
reports, refer to the following manual, Authoring
Reports Using Microsoft SQL Server 2008

To create and manage ad-hoc reports, first launch the ad-hoc reporting tool from your user

account.

NOTE: The Microsoft Report Builder tool is a stand-alone software program and will need to be

installed on your computer the first time you run it. Depending on your account privileges,

your network/system administrator may need to complete the setup.

To launch ad-hoc reporting
1. Logintoyour user account.

2. From the Reporting menu, select Ad-Hoc Reporting.
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3. Click Launch Ad-Hoc Reporting.
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review the information below and download the training documents.

& 2 4 3

Home

View »

- = The B2Gnow ad-hac reporting tool offers powerful functionality to build and run
Search » advanced reports. Authorized users can access published “data models® that
R = T are compilations of all relevant fields and parameters in the system fora

variety of useful record types. You can customize the included fields and

formats, plus filter, sort, and layout the results. Users that have experience with
~ Microsoft Access, SQL Server, Oracle, or Crystal Reports will find the tool
relatively easy to use.

Recent B Favarites
Full List
View Report Output

Scheduled Reports g
e e First Time Users Resources
Saved Output

Ad Hoc Reporting Merlyingtecnnology is Microsoft SQOL Server 2008
eporting Services and Reporting Builder 2.0. The Microsoft

Recent & Favorite Reports | Ful Report List | Report Output| Scheduled Reports | Saved Reports | Ad-Hoc Reporting |

Click the button to launch the B2Gnow ad-hoc reporting tool, which will open in a new window. If you are a first time user, please

Launch Ad-Hoc Reporting | < ece—

. Microsoft®
:“%b SQL Server2008 ~

Reporting Services

"‘ B2Gnow Ad-Hoc Reporting User Manual (4.5 MB)

-

vioen
@ rer @UET

Create » LI Report Builder tool is a standalone software program and will

4. If you are presented with a security login, enter your account username and password

and click OK.

Creating Table or Matrix reports

The “Table or Matrix” report is a traditional spreadsheet style report that you can generate in

minutes. Your data results display in sorted rows and columns.

To create a table or matrix report

5. Inthe Click to add title field at the top of the report, enter your report title.

6. Click Table or Matrix in the main window.

Untitled - Microsoft SQL Server Report Builder

L9 &

7¥/| Home | Insert

-1 Built-n Fields

View

ENEES e | ]| L Merge

|_-'1".\I>,A | gy ! il l E] —

Run paste /B L U |A -| A A [ Az -] s e 7 Splif

|:‘|;| Align +

Views Clipboard Font Number Layout
Report Data I 3 I 4 I T
New = Edit.. X & 2 | — =2

+-{_] Parameters
L. Images

Click to add title C———

Clickto add data

o— s B
Table or Chart
Matrix

[&ExecutionTime]

| No current report server
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7. Click Browse to open the Data Source selection window.

Mew Table or Matrix x|
Choose a connection to a data source
Choose a published data source, or create a connection for use only in this report.

Data Source Connections:

HoustonConven
2| nttpswadhocmwdbe.com/Reportserver/City of Houston/Data Sources

Browse... | MNew...

j—uh
Help < Back | Mext > | Cancel |

8. Open the folder with your organization’s name, and then open the Data Sources folder.

9. Select the Data Source file you want to use, and then click Open.

10. Click Next.

11. In the Fields list, double-click the fields you want to add. You can also drag and drop the
fields into the top right field area.

New Table or Matrix x|
Design a query

Build a query to specify the data you want from the data source.

PedtasText Fimport., | 9 O | 1 7 Fiter

HoustonConven =
a =
Entities: =
=l Contract List
= vendor Contract Statu  Contract Contract Vendor
0000 0.00  x00000000000000000

(RN

Fields:
# Contract ID
4 Contract Number
A4 Master Contract Number
a Reference 1
A Reference 2
4 Reference 3
4 Reference 4
A Reference 5
4 Status
A secondary Status
4 Contract Title

# Contract Value -
# Original Contract Value LI | 2

Help < Back Mext > | Cancel |
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12. To see a sample of the data fields selected, click the exclamation point icon near the top

of the window. To apply a filter (e.g. all contracts awarded after 1/1/2006), click the Filter
icon.

Mew Table or Matrix x|
Design a query

Build a query to specify the data you want from the data source,

DEdtasText Bimport.. | 4 0] 1 7 Fiter < mm———

13. Click Next when all the field selections are complete.
14. From the Available fields area, drag each variable to the Values area in the order you
want them to display on the report, and then click Next.

Mew Table or Matrix x|
Arrange fields

Arrange fields to group data in rows, columns, or both, and choose values to display. Data expands across the page in column groups and
down the page in row groups. Use functions such as Sumn, Avg, and Count on the fields in the Values box

Available fields T Column groups

Contract_List

Contract_Mumber

Status

Contract_Title

Contract_Value

Vendor_Organization

= Row groups % Values

Contract_MNumber -
Status -
Contract_Title -
Sum(Contract_Value) -
Vendor_Organization -

Help | < Back Mext = Cancel

15. On the Choose the layout page, click Next.
16. Select the report style you want to use, and then click Finish.
17. To run the report, click the Run button or press F5.

| 'UT Untitled - Microsoft SQL Server Report Builder .= x
e ————
| Home ! Insert View
] | ~ v| [ = T = | Merge
e s I & Split
Paste  |||[B I U ||A -[|A a = ||| B< R X y [=0 pli
k It i | o
Views Clipboard Font Paragraph Border Number Layout
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18. To save the report, click the Report Builder \___/ icon, then select Save or Save As. Open

the folder with your organization’s name, and then open the Reports folder. Name your
report file using something that clearly represents the contents and click Save.

All users from your organization have access to the same Reports folder so that reports can
be created by anyone and run by anyone. Do not modify or delete other user’s reports.

Do not save report files to a location other than the B2Gnow server. Reports saved to other

NOTES:
locations may lose compatibility with B2Gnow’s ad-hoc reporting function.

To maintain a clean environment for all users, from time to time the Reports folder will be
cleaned of test reports. Accurately name report files to ensure they are not inadvertently

deleted.
Adding page headers and footers
If you prefer to put the report title in a page header that will appear and print on every page,
Report Builder provides full design functionality.
To add a header or footer
1. Right click on the blue background of the report design window.
[ r——————
'_:I'%'.__ H ) Untitled - Microsoft SQL Server Report Builder o e R
U ! Home _! Insert View 7
'j’lw S e T = =i i | o et
pon || paste - |||B Z U |A-||A & 1258 % o |50 o EESPI
s = i ".Ju Align -
Views Clipboard Fant 7] Number Layout
Report Data R S A A L AL R R --‘4-‘-1‘--5--@.‘.
New = Edit.. X i Et
{_J Built-in Fields
i~ Parameters 5| AddPage Header
Ej ::ii::n[:om‘en 7 Sample REEJ Remove Page Footer
" j;ti;s:;;act_mt i Contract Nu Status Cfl Beoxtiioosies Contract Va Vendor Org
et i [Contract_Numt [Status] [Contract_Title] [Sum(Contract_ [Vendor_Organi
[&ExecutionTime]

--[Z=] Contract_value

[

T —

{221 vendor_Crganization
o

|_f5 Current report server https:ffadhoc. mwdbe. com/Reportserver

2. Select Add Page Header or Add Page Footer.
3. To move the report title to the header, drag the field to the header.
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Updating data display characteristics

AD-HOC REPORTING

You can modify data display characteristics by updating field formatting in your report.

To update data display characteristics

1. Click Design if not already in design view.

Untitled - Microsoft SQL Server Report Builder e e R
1 b bd 43 Refresh " ) ;l =& j Document Map :
. L@ |anll T !
it Moo e g S ton Print  Page Print | Export | i Parameters
Back Setup Layout =
Navigation Print Export Options Find
2. Click the data box of the data field you want to modify.
¥ =3 " " 4
IL.:-:j H ) Untitled - Microsoft SQL Server Report Builder s S
=)
= ! Home ! Insert Wiew 7]
= & = 1 Merge
b?[}) o ITahoma +| |10 VI = Ilpt j & - IDefau\t . d o
Run | Paste B I U|A-A A= —g-ml=m-]s % o d Spli
L = — @
“-l'.l Align =
Views Clipboard Font [F} Border [F} Number 7} Layout
Report Data 1|2|[3 | 4 1 .5 .
New - Edit.. X b=t
{3 Built-n Fields
[l Parameters 3
3 nages : Sample Report
[l HoustonConVen R e e R R T
-] DataSetl
=] Contract_List 3 0 0 endor Org
Contract_Number ||| = [[Contract_Numk [Status] [Contract_Title]j[Sum(Contract_ [Vendor_Organi
Status 2 & B
[==1 Contract_Title LA
--{==] Contract_Value i & Cut
-~{Z=] Vendor_Organization 43 copy
5 Paste
i
2 x Delete
Select ol
[&ExecutionTime]

1

JF  Expression...

|47 TextBox Properties...

Tablic

iJD Current report server hittps: /fadhoc.mwdbe, com/Reportserver

Insert Column

w

Right click and select Text Box Properties.

: 4

4. You can adjust field formatting, alignment, font, border, fill, and visibility. Click OK to save

changes.

5. To apply your changes, click the Save icon in the top menu.

Updating field width

To customize the report layout to better fit on the page, you can update the width of your

fields.
To update field width

1. Click Design if not already in design view.
2. Click the data box or data field you want to modify.
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3. Using the gray boxes that display above the field, drag the borders to update the width.

T T
@) u2c

New.~- Edit.. X ¢ &
-3 Built+n Fields

) Untitled - Microsoft SQL Server Report Builder ISR — i ¢
BAs ) a——
= | Home | Insert iew @
ng\_)]i ] & ITahuma - 'I " | |1pt j !&il IDefau\t j il Merge
i I
— Ha || i "_v; e = al !'_v]' o 7ET 14 Split
Run | Paste B 7 uA-A A‘i— = -] % 2| e
e S i Align =
Views = Clipboard Font [P} Paragraph [F1 Border [F1 Number [F] Layout
Report Data 5 BM T 2 | 3 I 4 | 5

[ Parameters
i3 Images

E& HoustonConVen
-] DataSet1
{=] Contract_List
| Contract_Number
| Status
| Contract_Title
=] Contract_Value
-+[Z2] Vendor_Organization

Title
[Contract_Title]

Contract Va Vendor Org
[Sum(Contract_ [Vendor_Organi

4

[&ExecutionTime]

ijD Current report server https: ffadhoc.mwdbe. com/Reportserver

4. To apply your changes, click the Save icon in the top menu.

Adding fields

To create a more comprehensive and informative report, you can add more fields.

To add fields

1. Click Design if not already in design view.

2. From the left Report Data window, right click on DataSet1 (or the name of the data set

you previously created) and select Query.

New ~ Edit., X &
[¥-{13 Built-n Fields

Z@T Untitied - Microsoft SQL Server Report Builder _ = x
\:'/ | Home | Insert View (7]
== fy I—_l_ I__l' E 1 Merge
L'_jrgj = _: L e —— i split
Run | Paste Bz U A& Q| |'~;.;Ahgn-
Views | Clipboard Font Paragraph Border = Number Layout
Report Data l | T e S G e SR EETTRERCRET

|»

Parameters

Sample Report

Add Query Field...
Add Calculated Field. ..

=
x

[“f Dataset Properties

Query... |
Delete

1tract Nu Status
tract_Numk [Status]

Title
[Contract_Title]

Contract Va Vendor Org
[Sum(Contract_ [Vendor_Organi

[&ExecutionTime]

{jz) Current report server https:/fadhoc. mwdbe.com/Reportserver

B2Gnow Support e support@b2gnow.com

9-7



BZGNUW AD-HOC REPORTING

3. From, the Fields list, double-click the fields you want to add, and then click OK.

=0
DedtAsText [Smport... | 4 (| 8 F Fiter

HoustonConven

|+

i

Entities: %
[ Vendor

Contract Statu Contract Contract Vendor Secondary
0000 0.00

Fields: i
# ContractID i’
4 Contract Number
a Master Contract Mumber
a4 Reference 1
a Reference 2
a Reference 3
a Reference 4
a Reference 5
4 Status
a
4 Contract Title
# Contract Value
# Original Contract Value

a Summary

-
A Special Notes j | | LIJ
Help | oK | Cancel |

4. From the DataSet1 field list in the left Report Data window, drag the fields you selected in
the previous step to the Design area.

¥
[ !}%\.ﬂ \ H ) Untitled - Microsoft SQL Server Report Builder =2 X
— -

| Home | Insert View

I_'%:}P) -. L * ITahcma _|E 'I = = |1pt j& . |I?efau\tr ] j il Merge

mn  easte © |B Z U[A-[l& a2 e | | NN ] i
= =] 5 e |- e fll= Y| |5 Align -
Views Clipboard Fant & Paragraph ] Border 7] Number ] Layout
Report Data 1|2]3|4|5
Mew » Edit. X @ 3 | ' £l
[#H-{3 Builtn Fields

P ter 53

L moges . |Sample Report

=] ‘Q HoustonConVen
B 5] DataSet1

\=1 Contract_List Contract Nu Status Title Contract Va Vendor Org Seco
| Contract_Number —E iCUntract_Numt [Status] [Contract_Title] [Sum{Contract_ [Vendor_Organi
o] Status A=

| Contract_Title
| Contract_Value

[&ExecutionTime]

|jml]urrent report server https: {fadhoc.mwdbe. com/Reportserver :M | e

5. Click Run.
6. To apply your changes, click the Save icon in the top menu.
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Sorting fields

AD-HOC REPORTING

You can specify the order in which data in your report fields automatically displays.
Alternatively, you can design the report to allow viewers to set their own sort order by

enabling the Interactive Sorting option.
To set sort field order

1. Click Design if not already in design view.

2. Click any data field, then right click on the top left border square and select Tablix

Properties.

Untitled - Microsoft SQL Server Report Builder

Run Paste

Views Clipboard

1 Merge
i split

%5 align -
Layout

5]
w

Report Data ] ]
New - Edit.. X ¢ & J
{3 Builtin Fields

|»

-] Parameters
h L; Images

bample Report

=l HoustonConVen

£ DataSetl
-~[==] Contract_List
Contract_Number
Status
Contract_Title
Contract_Value
--{Z] Vendor_Organization

[Contract_Title]

Layout
Select

“f  Tablix Properties...

Contract Va Vendor Org
[Sum(Contract_ [Vendor_Organi

[&ExecutionTime]

ijg Current report server https: ffadhoc.mwdbe. com/Reportserver

3. Go to the Sorting tab.

Tablix Properties
General .
Change options.
Visibility
Filters Add | Delete | & | ! |
Sorting Calumn |Order

LN [Contract Title

=l il [atoz

[Contract_List]
[Contract_Mumber]
Status

[Contract_Value]
[Vendor Organization]

4. Click Add.

=l

5. From the Sort by list, select the field for which you want to change the sort order.
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B2GNeWw

6. From the Order list, select the method by which you want to sort the column fields.

By specifying a list of “Sort by” fields, you can create multiple levels of sorting. For example,

NOTE:
you can sort by business name, then ethnicity, then gender.

To set interactive sorting for report viewers

1. Click Design.
2. Select a data field header, and then use the right-click menu to select Text Box Properties.

[r——

:'L.\.E‘.;-j \\ H ) Untitled - Microsoft SQL Server Report Builder S ¢
= | Home | Insert View 7]
E-%) i Fahema i e | [t =] |% | pefut | :‘Ttge

b R s pr— { spli
Run Paste B I U A A A == — - - 1B 5 % i g =
— ! |5 align -
Views Clipboard Font [F} [F} Border [F} Number F} Layout
Report Data | 1 | 2 | . 1 . | 4 | 5 |
-

New - Edit.. X & = I

[#-_J Built4n Fields
i3 Parameters

1_] Images
=)+ HoustonConVen

-] DataSet1 L
/2] Contract List Contract Nu Status Title

ontract_Number i [ Contract_Numk [Status] [Contract_Title]

r_Organi

ontract_Value i
Paste

Vendor_Crganization = ste
: X Delete

ol
2 Select »

Jx  Expression...
F  TextBox Properties...

| 2Exec utlUnTlme-]“

Tablix
-
1 Insert Column 3 »
Insert Row v Gl

iJD Current report server hittps: /fadhoc.mwdbe, com/Reportserver

3. Go to the Interactive Sorting tab.
4. Select Enable interactive sorting on this text box.

Text Box Properties

Change name, value, and sizing options.

Mumber
Alignment Mame:
Eont ITex'tbm{S
Border Value:

[Title - A& |
Fill

ToolTip:
Wisibility

5 |

Interactive Sorting h
Action Sizing options

v Allow height to increase

™ allow height to decrease

5. Click OK.
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6. From the Sort by list, select the fields readers can use to sort tables.

NOTE: Viewers cannot sort results by multiple fields at the same time. For example, a viewer
cannot sort by Gender, then Ethnicity.

Accessing Saved Reports

1. To open asaved report, click the Report Builder icon, then select Open.
2. Open the folder with your organization’s name, and then open the Reports folder.
3. Select the report and click Open.

Converting Saved Ad-hoc Reports Into Standard Reports

Since ad-hoc reporting is limited to specific users in your organization, not everyone has
access to run the reports created. When you’ve created a report that needs to be run by
others in your organization, please contact B2Gnow Customer Support to request that the
report be converted to a Standard Report.
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Microsoft®
V3 SQL Server2008

~ Reporting Services

Authoring Reports Using Microsoft SQL Server
2008 Reporting Services Report Builder 2.0

This document provides step-by-step instructions for building several types of reports using SQL Server
2008 Reporting Services applications, and sample data. The document focuses on the new SQL Server
2008 Report Builder 2.0 application.
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Introduction

This document is a step-by-step instruction manual for building several reports using SQL Server 2008 Reporting
Services applications and sample data. The focus is on using the new SQL Server 2008 Report Builder 2.0
application. See the Required Environment section for the software required to complete these exercises.

Before You Begin

Estimated time to complete this lab

Basic Exercises 1 — 5: 30 Minutes

Advanced Exercises 6 — 9: 45 minutes

Objectives
After completing this lab, you will be able to:

Launch the new report designer application Report Builder 2.0.
Create a data source and a data set.

Design a new report using Report Builder 2.0.

Preview your report from the application and from Report Manager.
Enrich your report using the richly format-able text box.

Enrich your report using a chart.

Enrich your report using gauge.

Enhance your Tablix and create two dynamic column groups.

Add end-user power by adding dynamic filtering.

Required Environment
This lab requires the following:

Microsoft SQL Server Reporting Services Report Server, for publishing reports.
Microsoft SQL Server 2008 Reporting Services Report Builder 2.0:

http://www.microsoft.com/downloads/details.aspx?familyid=9F783224-9871-4EEA-B1D5-
F3140A253DB6&displaylang=en

Microsoft SQL Server 2008 Adventureworks Sample Database:

http://www.codeplex.com/MSFTDBProdSamples/Release/ProjectReleases.aspx?Released=1
8407

B2Gnow Support e support@b2gnow.com 9-15
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Lab Scenario

You are a report author for AdventureWorks—a sporting goods retailer. You have a requirement to develop a
new report that displays product sales information. The report is to be designed to show aggregated sales data
using two-level dynamic groupings on both the row and column axis. You also need to create an advanced
report that leverages some of the new design capabilities introduced with Reporting Services 2008.

A Reporting Services 2005 table enables quick and easy groupings of basic data. A Reporting Services 2005
matrix enables complex groupings of data, including nested groups and inner static members within dynamic
columns. In Reporting Services 2008, a new data region called Tablix, combines the table and matrix features,
combining the best of both. Therefore, the new Tablix functionality allows you to build reports that include the
following:

e Multiple parallel row/column members at each level

e A mix of dynamic or static members on both rows and columns

e Optional omission of member headers

e Arbitrary nesting on each axis
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Exercise 1: Getting Started and Getting Familiar with Report Builder
In this exercise, you will:

e Launch Report Builder 2.0 (RB2).
e Get started with a blank design surface for creating a new report.

e Review the various key areas of the RB2 user interface (Ul).

Launching Report Builder 2.0

To launch the Report Builder, perform the following steps:
1. On the Start menu, click Programs, then click Microsoft SQL Server 2008 Report Builder 2.0.
2. Click Report Builder 2.0.

Report Builder 2.0 launches with a blank report, as shown in Figure 1.

‘ Home | Insert View

';@-) bWa e ) Untitled - Microsoft SQL Server Report Builder . = x
R

{73 Merge

AIEE
u1lp) I &5 [IF T
Run | Pasts B I U|A-A A

i split

123 .“ $ % o % 5%

| |9 Align ~
Views Clipboard Font Paragraph Number Layout

Report Data SE dEr GEE B dEm SEE ded GRC GEE e OSRC CHE dEr 0 fe JmE GO f8C B e 9Ek g J Properties

New - Edit.. X & 3 = | Report

3 Built-in Fields : ; Sail=

L. Parameters s = -

=i i Click to add title i S Code z

ges 5 H Code

E Data Only
DataElementh
DataElements Attribute
DataSchema

Click to add data
= Ii‘} §+ i DataTransforr
- Table or Chart S General
Matrix i T
Description
Width 432pt
B Localization
| 4 Descriptionlo
Language
E Other
e ——— | —————————————— " AutoRefresh 0
=] Row Groups T Column Groups = ConsumeCon False
CustomProp
B Page
Eackgmund[l:l Automatic

m AT
Assemblies

Specifies the assemblies that the
report references.

m

m

[&ExecutionTime]

|;JD Mo current report server

Figure 1: Creating a New Blank Report Using Report Builder 2.0.
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Note

tab and select all four items.
M
NS
Haome Insert View
Report Data Grouping

Properties Ruler

i

ShowfHide

If your screen does not have all the same windows open in RB2, in the Menu bar, click the View

Exploring Key Areas of RB2.0

The following table describes several key areas of the Report Builder 2.0 User Interface.

#-_ Built-in Figlds
=~ Parameters
g whichSaleOrderID
L
= _J;. mylocal_adventureworks
=] salesorderheaders
[z=] salesCrderID

=1 revisionhimber

Area Image Notes
R rtD . .
eport Data Repart Data This panel provides
Mew - F access to create and use

data sources, data sets,
parameters, and
images—all the key
pieces of information
you would want to use
in your report creation.

Properties Properties

Body

(o2} | E

= Border
BorderColor  Black
BorderStyle  Mone
Borderwidth  1pk
= Fill

BackgroundCol [ | Mo Color
BackaroundIm:
E Position
Size 5.5in, 2.25in

This panel lists and edits
the detailed properties
of the current report
item (textbox, line, and
so on) or report section
(header, footer, and
body).

The most common
properties are also
exposed in property
dialogs when you right-
click an object.
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Area

Image

Notes

Grouping

= Row Groups

This section enables you
to manage the
properties of all of your
groups for Tablix report
items (table, matrix,
list). You can easily
create groups using the
window, or dragging
fields to the grouping
window.

Server status in
status bar

I |_4[3 Current repart server bkkp: fflacalhostrep

This area reports the
current report
server/connection
status. The server can
be changed from the
Report Builder icon
menu and choosing
Options.

Zoom control in
status bar

Report Builder 2.0
supports zooming in
design and run mode.

Context menus

CIiCE

=| Remove Page Footer

| View

> |

Add Page Header

“f Report Properties...

Ruler

Grouping

ckto add data

RB2 consists of a rich
set of context menus,
for accessing almost
every feature, including
the virtual space around
the report.

Snap Lines

Ll
T

Design Surface Snap
lines help align objects.
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In this exercise you will create a shared data source on the report server, which can be used for multiple reports.
Utilizing shared data sources on the server allow centralized management of connectivity to data sources.

Creating a Shared Data Source

To complete this exercise, perform the following steps:

1. Open Internet Explorer and type in the URL of the report manager of http://localhost/Reports (or your

server URL) and press ENTER.

2. Click New Data Source in the Contents page of the Report Manager, as shown in the Figure 2.

I Report Manager, - Windows Internet Explorer, provided by SSRS Report Authoring |Z||E|rz|
S thp:floc: ulge Pages/Folder . aspx V| || % | | P |-
—_— - - >
W [@Report IManager ] l ﬁ - B ety - |:2b Page ~ {0 Tools -
Home | My Subscriptions | Site Settings | Help
EQL Server Reporting Services -
Home Search for:|
Contents Wil ol

[iMew Folder &»MNew Data Source 4] Upload File 3] Report Builder i Show Details

[ My Reports [ Users Folders

Use this folder to store personalized reports.

Figure 2: Report Manager

3. On the New Data Source page, perform the steps:

e In the Name field, enter LocalAdventureWorks.

e For Data Source Type, select Microsoft SQL Server.

e Enter the following in the Connection String.

Data Source=localhost;Initial Catalog=AdventureWorks2008

e Near the bottom, click to select Windows Integrated Security.

4. Click Apply.

5. Minimize Internet Explorer to return to it later to preview reports from the server.
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Exercise 3: Table and Matrix Wizard—Data Sources, Data Sets, and
Building a Matrix

In this exercise, you will:

Design a new report using the Table or Matrix wizard.

Specify the report data source. The data source to be used is the AdventureWorks sample database that
you can download from Codeplex. (See references section at the end of the document).

Specify the Report Data Set. The data set is generated from a custom query that returns sales data, including
ProductCategory, SubCategory, Product, and Year.

Specify fields and groupings.

This exercise demonstrates how to create a report showing Product Category and Sub Category for the row
axis, and Region and Order Year for the column axis.

Select report layout of style and colors.

This exercise assumes that you have completed Exercise 1.

Designing a New Report Using the Table or Matrix Method

To design a new report, follow these steps:

1.
2.

Open the Report Builder 2.0.
In the new blank report, click the Table or Matrix wizard link in the center of the screen.

The wizard walks you through creating a Table or Matrix. The process includes the creation of the required

data source and data set.

P

.¢.

Table ar
Makrix

Note

You can also access the wizard from the toolbar by selecting Matrix Wizard from the Matrix
Menu as well as the Table Wizard from the Table menu, both in the Insert tab. The icon in your
new report disappears after you run the wizard the first time. However, you can re-run the
wizard at any time from the Insert ribbon.

3. At this point, you may briefly see the server dialog informing you the application is connecting to the server.

B2Gnow Support e support@b2gnow.com

The new Table or Matrix Wizard dialog appears. Select the existing data source connection
LocalAdventureWorks, and click Next.
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-

Mew Table or Matrix @
Choose a connection to a data source

Choose a published data scurce, or create a connection for use only in this report.

Data Source Connections:

L LocalAdventureWorks
*HJP httpy/flocalhost/reportserver

[ Browse.., ][ New...

Mext = ][ Cancel

Figure 3: New Table or Matrix Wizard

If you cannot see the shared data source you previously created, click Browse to find the data source on the

server.

Specifying the Data Source

To browse to your specific data source, perform the following steps:

1. Double-click the server name: http://localhost/reportserver
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Select Data Source x|

Loak in; IL__"..F Recent Sikes and Servers j #

‘% lj:_a http:f flacalhostfrepartserver

Recent Sites
and Servers

=
[
Deskkop

9

My Documents

My Compuker

Marme: Is Cpen I

Ikems of bype: |Data Sources (*,rsds, *,smdl) j Cancel |
A

Figure 4: Browse Server to Data Source

2. Double-click the LocalAdventureWorks shared data source you previously created.

Select Data Source

Look in: Ig http: flocalhostfreportserver

T My Reports
1 | Users Folders

Recent Sites e LocaladventureWarks

and Servers

Figure 5: Select Your Data Source

3. Click Next to move to the Query Design step of the wizard.

Specifying the Data Set

Here, the data set is generated from a custom query that returns sales data, including ProductCategory,
SubCategory, Product, and Year.

It follows that the next step in the wizard is to create a query (or a data set) for the matrix.

To streamline the process, perform the following procedure:
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1. Copy and paste the query instead of building a query manually.

Note

With the new Query Designer in Report Builder 2.0, you can explore the schema of your data
source to make it easier to build queries. You can also import the query syntax from a file using
the Import functionality.

Design a query

Build a query to specify the data you want from the data source,

o Edit As Text (55 Import... |

Database view Selected fields

t-[_d dbo

i -4 HumanResources
|4 Person

+-[_J Production

-4 Purchasing

i - Sales

Relationships
Applied filters

Field name Operator  Value Parameter

Query results

[ < Batk H Mext = l[ Cancel

Figure 6: Query Designer
2. Click Edit as Text to switch the query designer to text mode.

3. Select all the query text below, copy it, and paste it into the query editor.

SELECT
PC.Name AS ProductCategory,
PS.Name AS SubCategory,
DATEPART(yy, SH.OrderDate) AS OrderYear,
'Q' + DATENAME(qq, SH.OrderDate) AS OrderQtr,
SUM(SD.UnitPrice * SD.OrderQty) AS SalesAmount,
Sales.SalesTerritory.[Name] AS Territory,
Sales.SalesTerritory.[Group] AS Region

FROM
Production.ProductSubcategory AS PS JOIN
Sales.SalesOrderHeader AS SH JOIN
Sales.SalesOrderDetail AS SD ON SH.SalesOrderID = SD.SalesOrderID JOIN
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Production.Product AS P ON SD.ProductID = P.ProductID ON PS.ProductSubcategoryID =

P.ProductSubcategoryID JOIN
Production.ProductCategory AS PC ON PS.ProductCategorylID = PC.ProductCategorylID JOIN
Sales.SalesTerritory ON SH.TerritorylD = Sales.SalesTerritory.TerritorylD
WHERE
(SH.OrderDate BETWEEN '1/1/2003' AND '12/31/2004')
GROUP BY
DATEPART(yy, SH.OrderDate),
PC.Name,
PS.Name,
'Q' + DATENAME(qq, SH.OrderDate),
PS.ProductSubcategorylD,
Sales.SalesTerritory.Name,
Sales.SalesTerritory.[Group]

At this point, we suggest you execute the query to ensure everything is working—you can verify this by

seeing rows populated in the results pane at the bottom. To execute the query, press '

Design a query

Build a query to specify the data you want from the data source,

2 Edit As Text L_:":Import...l ! Command type: |Text -

SELECT »
PC.Hame AS ProductCategory, N
P5.Hame A5 SublCategory,
DATEPART (vvy, SH.CrderDate) AS Order¥Year, £
'Q' + DATENAME (gg, SH.OrderDate) AS OrderQtr,
SUM ({5D.UnitPrice #* S5D.0rderQty) AS SElesilrr.o;]lnt,
Sales.S5alesTerritory. [Name] AS Territory,
Sale=.5alesTerritory. [Group] 45 BRegion
FRCM
Production.ProductSubcategory &5 PS5 JOIN
Sales.S5alesCrderHeader 45 5H JOIN
Sales.SalesCrderDetail A5 5D CN SH.SalesCOrderID = 5D.SalesCrderID JOIN
ProductCategory SubCategory OrderYear OrderQtr SalesAmount Territory Region ol
Components Headsets 2003 1 22946722 Canada Morth America .
Accessories Locks 2003 Q1 60,0000 Central Morth America
Bikes Mountain Bikes 2003 Q3 2814497419 Central Morth America
Bikes Road Bikes 2003 4 888325.2180 Southwest Morth America
Clathing Vests 2004 1 2649.2200 Central Morth America
Components Chains 2004 1 24,2380 Southeast Morth America
Components Bottom Brackets 2004 Q2 2300.1240 Southwest Morth America
Accessories Hydration Packs 2004 Q2 31289310 Morthwest Morth America

[ <« Back ” Mext > ]’ Cancel

Figure 7: Text-based Query Design in the Wizard

4. Click Next to continue to arrange the fields.
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Specify the Fields and Groupings

In continuation with the Report Builder wizard, specify the fields and groupings in the following steps:
1. To arrange the fields (Column Groups, Row Groups, and Values), do the following:

a. Drag SalesAmount to the Values definition box.

b. Drag ProductCategory and SubCategory to the Row groups definition box.

c. DragRegion and then OrderYear to the Column groups definition box.

Mew Table or Matrix

X

Arrange fields
arrange fields to group data in rows, colurnns, or both, and chioose values to display, Data expands across the page in column
groups and down the page in row groups, Use functions such as Sum, Avg, and Count on the fields in the Walues box,
Available Figlds T Column groups
ProduckCategory Reqgion
SubCategary
Orderfear Orderiear
Ordertr
Salesamaunt
Territaory
Reqion
Row groups = Values
ProductCategory Surn(SalesAmaunt) -
SubCateqary
[ <Back | [ Next = l [ Cancel

Figure 8: Arrange fields in the Wizard to Specify Groups and Values

Note

If you drag a field to the wrong location, you can fix this by dragging it from one definition box to
another, or to the white/blank space in between them to remove it.

2. Click Next to continue.

Selecting the Layout and Colors

1. Select the visual layout.
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For this exercise, use the default Blocked, subtotal below layout. We recommend clicking the other options
to understand the options available with the wizard, based on the preview.
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Note

The Expand/Collapse groups checkbox builds the report with group headers and totals shown,
but the detail rows will be hidden by default. However, the report will show +/- symbols on the
groups to allow you to expand and see the detailed rows while running or previewing the
report.

B Bikes Mountain
Bikes

Road Bikes

X]

Mew Tahle or Matrix

Choose the layout

If you choose to show subtotals and grand totals, you can place themn above or below the group, Stepped reports shiow
higrarchical structure with indented groups in the same colurnn,

Options: Preview

Shiow subkotals and grand tokals [Region]

[Order¥ear] Total

(%) Blocked, subtatal below
) Blocked, subtaotal above

) Stepped, subtotal above

Expandfcollapse groups

[ < Back ]l Met = |’ Cancel

Figure 9: Select the Visual Layout Type.

2. Click Next to proceed to the Style selection.
3. Select the style.

For the purpose of the exercise, we use the default Ocean style. From the wizard screen, it is possible to
modify the colors and the fonts even after wizard is complete.
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B2GNew

Mew Table or Matrix

X

Choose a style
Styles feature different fonts and color schernes, but do not affect the basic layout, ou can customize the style after you

finish the wizard,
Preview

Styles:

Carporake %
Forest
GEneric

Mahoiani

Slate

[Region]
[Order¥ear] Total

[ < Back. H Finish == l [ Zancel

Figure 10: Select a Color Style.

4. Click Finish to complete the wizard and view your new report.

Your report will look like the following figure:
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r(@\ (S, ] “‘; Unkitled - Microsoft SCL Server Report Builder _ = x
— Home l Insert Wigw (7]

B ¢ AR o] | | e

=| g — ; Split
Run || Paste — |1; I U A-l8A1[= — . | [12s -|| $ % | | Spli
— [55 align ~
WYigs Clipboard Farkt Paragraph Baordar Muriber Lavaut
Repork Diata LR L S - B rC SRR DR SR DL - SR B | Properties
Mew = Edit.. o | Selected Text
-3 Built-in Figlds IS_Z'El | __—'I
{1l Parameters . . . =
G lnages - |Click to add title B Action 5
-1 DataSourcel ) Action None
-] Datasetl N E Alignment
! ProductCategory - [Region] Indent

SubCategary s Product Sub [OrderYear] Total _ SpaceAfter
SpaceBefore

Ordetear .
Ordercitr . [ProductCatec [SubCateqgory [Sum{Salesamc [Sum(SalesAn | =0 EE R Textalign Right
SalesAmaunt _ Total [sum(SalesAn [Sum(SalesAn [Sum(SalesAnm El Font
Territary - Color Il Glack
Region . _ [Sum(SalesAm|[Sum{SalesAm [Sum({SalesAn Font Arial, 10pt, Defe
o LineHeight
- El General
ToolTip
T — B List:
“&ExecutionTime] Li':thevel o

ListStyle None
Bl Localization
Calendar Default
1] Row Groups 1T Column Graups - II;Ii::ng:rZ?:angue
Murneralvariant 1
WalueLocID
El Number

[ ProductCategory + | [ Region -
[ SubCategory - [ Ordervear -

Action

Specifies an action associated with the
report ikem, Actions include a jump k...

[ Mo current report server 2 | 100% (=) Y )

Figure 11: Completed Wizard

Note

e Notice your data source and data set in the Report Data window on the left.

e Asyou click on the each field in the grouping window, it is selected in the Tablix. The column and row
selectors provide an additional visual cue of how elements are grouped. For example, if you click on
[ProductCategory] in the Row Groups area, you can see the grouping indicators such as below:

:

Grouping Indicators

e Try the Zoom slider on the status bar at the lower right corner of the screen.

To run the report, perform the following procedure:

1. Click the Home tab, and click Run button or press F5.
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Your report will look similar to the following.

‘/'\ ;, @ ) SalesbyRegion_exerciseZrd| - Microsoft SQL Server Report Builder _ = x
iy ‘_J J

~ | el @

T 1B .  Refresh | i [ E [ DocumentMap || —
B[S | e #
Design | Zoom || First Previous i Next Last * stop Print Page  Print Export % Parameters
> 4 Back Setup Layout ~
Views | Zoom Navigation Print Export p Find

Product Sub Category
Category
= Bike Racks ~ 157240.8000 239437.2000
Bike Stands 39591.0000
64353.5989
18518.5710
46619.5800
392115.4294
106329.7638
6159.0000
5145.4260

15897306.9833 45060716.7241 7220537.9250 63178561.6324

9/16/2008 6:16:12 AM

PR

Figure 12: Completed Wizard with Expanded Accessories Product Group

2. Use the Expand and Collapse (+/-) functionality in the Accessories group to explore the report.
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Note

e The Export button on the Run ribbon includes various options for export formats.

ﬁ Document Map
ll'g;
Expart @, Parameters

-

XML file with report data '
CSV (comma delimited) !
TIFF file

Acrobat (PDF) file
MHTML (web archive)
Excel

Word

Export Menu

e Try the run time Zoom functionality on both the Ribbon and the lower right status bar.

i = :|
%
Zoom

-

<=1
+

Zoom =

3. To switch back to design mode, Click Design or press F8.

4. To save your report to the server, do the following:

(="

a. Click the Report Builder icon E;U , then click Save As.
b. Double-click My Reports in the folder list.
c. Enter the file name SalesbyRegion_ex3.rdl.

d. Click Save.

Save As Repork

Loak in: I '_—E htkp: fflocalhostjreportserver

== 1My Reparts
i |1 Users Folders
Recent Sites
and Servers

If you are unable to see My Reports, perform the following steps to save the report:
a. Click Recent Sites and Servers in the left panel.
b. Double click http://localhost/reportserver.
c. Double-click My Reports.
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If My Reports was not enabled on the server, you can save to the root of your report server.
d. Enter the file name SalesbyRegion.rdl.

e. Click Save.

cave As Report x|

Look in: Il:'ihttp:,I',I'II:u:aIhnst,l'repnrtserver,l'f‘-’ly Reports j |_2|

‘g There are no items in this lisk,

Recent Sites
and Servers

F" —
[
Desktop

9

My Docurents

o

My Computer

Mame: ISaIesbyReginnlrdl Save I
Items of bype: IRepDrts i*,rdl) j Cancel |

Figure 13: Save As Dialog
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Exercise 4: Enhancing Your Report with Richly-Formatted Text

In this exercise, you will:

e Enhance the look of your report by using rich formatting on a report title.

e Use place holders for dynamic text.

This exercise assumes that you have completed Exercise 3

Enhancing the Look of the Report

To enhance the look of the report, follow these steps:
1. Open the SalesbyRegion_ex3.rdl report created in the previous exercises, if it is not already open.
2. To set the sum fields to show currency format, do the following:

a. Click the upper-left sum field, the Sum(SalesAmount) under [OrderYear],

b. Hold down the SHIFT key, and click Sum(SalesAmount) in the lower-right corner to select all of the
sum fields.

.E[Drder"l"e.a r]

b
c. Click the currency format button on the ribbon.

$320,970.87 $681,088.99

£12,636,198.45 $37,438,536.66

You can also click and format each field individually. When you run the report, you will see the
currency format. When in design mode, you can resize your columns wider so numbers do not wrap.

Note

The ribbon allows you to toggle the design time view of placeholders from sample values to actual
placeholder text.

ICurrency j
123+ § % |56 5%
Placeholders

I Sample values ;_

3. Click in the textbox at the top of the report showing Click to Add Title, and enter a title Sales by region.
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4. Select the word Sales you just typed in, and use the Ribbon to format the font color to red.
5. Select the words by region and use the Ribbon to change the font size to 10.
6. Click between the words Sales and by and press ENTER.

This creates a line break with the small text forced to a second line. You can resize the title textbox and
move the Tablix down. The design view of the report looks like the following figure.

Sales
by Region

[Region]
Product Sub [OrderYear]
[ProductCategory [SubCategory [$12,345.00] H

Figure 14: Formatted Report Title

Using Placeholders for Dynamic Text

To use placeholders, perform the following steps:
1. Click in the textbox in the lower-right corner of the page footer showing [&ExecutionTime].

This text box contains a Place Holder specifically for the built-in field ExecutionTime, which prints the time
at which the report was executed on the report.

2. Type Executed: before the [&ExecutionTime] so the whole string is Executed: [&ExecutionTime].

3. Expand the Built-in fields list in the Report Data window, and drag Page Number to the lower left corner of
the report footer.

A new text box is created with the [&PageNumber] place holder.

Repork Daka
Mew - e

[=+{ = Built-in Figlds
[z=] Execution Time
[z=] Page Mumber

[=] Report Folder Total -

Z=| Repart Mame
D ........... D ..................... .|:|
d[&PageNumber o

4. Click the right edge of the new textbox and resize the box to the right to make the textbox wider. You can
also use SHIFT+ Right Arrow to resize the box.
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[ﬁ"agamumber] D Executed: [&ExecutionTime]

5. Inthe text box, type of after the [&PageNumber] place holder, and from the Report data window, drag
Total Pages to the end.

6. Select the text and make it bold. You can make the selected text made bold by pressing CTRL+B, similar to
Microsoft Office Applications.

[@ageﬂumher} of [&TotalPages] 0 Executed: [&ExecutionTime]

7. Torun the report, click the Home tab, and click Run or press F5.

The placeholder now changes to actual values. For example, here, the [&ExecutionTime] placeholder is now
a date and time.

By default, the report layout appears in a small/collapsed size. If you expand several product categories (+), and
switch to the layout mode, the page total reflects the increased number of pages. To change the layout, click the
Print Layout button in the ribbon.

[ —

|

Prink
Layouk

Click Design or press F8 to return to Design view.

Note

This exercise only gives you an idea of how you can enhance your report with the new text box and the ability
to richly format your text. Various combinations of static text (such as Executed), placeholders, support for
one to many lines, numbered or bulleted lists, paragraph alignment, and the rich font formatting make the
new textbox a powerful addition in SQL Server Reporting Services 2008.

I Save your report to the server: To save your report on the server, perform the following steps:
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1. Click the Report Builder — icon, then select Save As.

2. Select the My Reports folder, if present, on your local server.

3. Enter the file name ‘SalesbyRegion_ex4.rdl’.
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Exercise 5: View Your Report from the Server

In this exercise, you will:

e View your report from Report Manager using Internet Explorer.

AD-HOC REPORTING

This exercise assumes that you have completed Exercise 4

Viewing the Report from Report Manager

To complete this exercise, follow these steps:

1. Open Internet Explorer and type in the URL to the report manger of http://localhost/Reports, then press

ENTER.

2. Click My Reports to open the folder.

3. Click the SalesbyRegion_ex4 report (or the name you saved it as) il SalesByRegion ex4 Inew

Your report looks like the way you saw before when you ran it inside Report Builder 2.0.

- Report Manager, - Windows Internet Explorer. provided by SSRS Report Authoring

CEEX

Figure 15: Report Manager
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Home | My Subscriptions | Site Settings | Hel
T . . Help
QL Server Reporting Services -
Home Search for:l |
Contents W07 6
]
[iNew Folder &»New Data Source 4] Upload File 5] Report Builder £ Show Details
[d My Reports [ Users Folders
Use this folder to store personalized reports.
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| ’ Report Manager - Windows Internet Explorer

=10 x|

G@ - IE http:fflocalhost/Reports/Pages/Report, aspx?ItemPath="%2fMy+Reports32f SalesbyRegion

j E] [z] ILive Search EE]

File Edit Wiew Favorites Tools Help

ﬁ 493 @ReportManager | |

- - (= v |k Page v (0 Tooks - ?

SQL Server Reporting Services

Home = My Reports =
SalesbyRegion
AN Properties | History ]| Subscriptions
4

Home | My Subscriptions | Site Settings | Help ;I

Search for:l

»

Find | Next Select a format

= |

S

LI Export

4 - Tefr b pI [roo%
Select a format

XML file with report data
CSV (comma delimited)
Acrobat (PDF) file

MHTML {web archive)

| T

Sub Category

| Product
| Category

15897306.9833| 45060716.7241
9/16/2008 7:55:13 AM

7220537.9250| 63178561.6324

Figure 16: Viewing the Report in Report Manager

Note that the same export options in the Report Builder 2.0 application are available in the Report Manager as

well as zoom and printing.

The Role Report Manager also enables you to assign permissions and create Subscriptions for reports, and can

automatically e-mail the report results to required e-mail aliases. This

for example every morning at 8:30.
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Exercise 6: Enrich Your Report Using Charts
In this exercise, you will:

e Add a basic Chart to the Report you previously created.

We will manually build a simple chart rather than use the wizard to get a feel of modifying the report items.
SQL Server Reporting Services 2008 introduced new Data Visualization functionality in the form of a richer
chart report item, and an all-new gauge report item.

Note

The Data Region report items such as Chart, Gauge, and Tablix are only allowed in the Report Body section,
and not in the Header and Footer sections.

This exercise assumes that you have completed Exercise 4.

Adding a Basic Chart to Previously Created Report

To add a Basic Chart to a previously created Report, follow these steps:
1. Open the previously created report, SalesbyRegion4_ex.rdl.
2. To add a chart report item to the design surface below your existing Tablix, do the following:

a. Create some space at the bottom of your report by dragging the report body sizing handle down in

the vertical ruler. This will create a blank space below your Tablix, and will be used to accommodate
the chart.

[&PageNumber] OF [&To

3. Inthe ribbon, click the Insert tab, then select Insert chart under Chart. The mouse cursor is now in Insert
mode.

4. Place the pointer to upper-left corner of the new chart, or drag to place and size the new chart.
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5. Clickimmediately beneath the lower-left edge of the Tablix in the Report body.

The Select Chart Type dialog box appears.

Select Chart Type k
P [ -
= ] 28] (28] 9] 9] 99 |0l

o a3 s8] 08| B

Area
Range Line
Scatter ~ A || 20" ‘e
‘ 4 N | ‘r;LT | . "1
Polar
Shape

O @ @] O] QY

Fel=SEEE

l Ok J [ Cancel l

Figure 17: Selecting the Chart Type
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6. Select the default column chart in the upper left corner, then click OK. N I : '

The chart report item is now placed on the design surface. There is no need to select a Data Source and Data
Set because the report already has only one, so Report Builder will have set it for you. The Design Time view

of your report will look like the following.

Sales

by Region

Total

product——sub [

[SubCategory [Sum{SalesAmount) [Sum(SalesAn

[Sum{SalesAmour [Sum(SalesAmo | [Sum{SalesAn

Chart Title

N Series 1

100
[ Series 7

B0
60
40
20

Az Tithe

c o E F
Axis Title

Executed: [&ExecutionTime]

[&PageNumber] of [&TotalPages]

Figure 18: Chart Report Item is Created
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7. To put the chart into edit mode, double-click the chart.

Your Chart report item now looks like the one below, with the field areas visible.

— s e DHIESAN DU DR
Drop data fields here [Sum(Salg
D--@ i |
Chart Title H|
o 1;’;' B Series 1
8 = & series 2 S Crop series fields
W] F
Z -'1:'3' here
a
A B C D E F
Axis Title
] ] ]
Drop cakegory Figlds here
[&PageNumber] of [&TotalPages] Executed: [,

Figure 19: Chart Showing Field Areas Where You Drag From the Report Data Window
In the previous Figure, notice that there are three editing areas.
8. Drag and drop fields from the Report Data window as follows:

e Drop data fields here — Area for fields that represent the numeric measures in the chart. In this
example, the data field would be the SalesAmount field, which represents numeric sales data. Drag this
field into the data fields area.

e Drop series fields here — Area for individual bars (series) within a category. In this example, if you want
to see one bar for each year of sales within a category, select the OrderYear series field. Drag this field
into the Series area.

e Drop category fields here — Area for categories of data. This area is represented by the A through F
labels at the bottom of the chart. In this example, if all series bars should be grouped by Region, drag
this field into the category area.

9. To change the chart title, double-click the title and enter Yearly Sales by Region.
10. To change the vertical axis title, double-click the text box and enter Sales (1k).
11. To remove the horizontal axis title, right-click the axis and clear the Show Axis Title check box.

0
Region A Reagion C Region E

Region B Ragion D Region F
Axis

Doy
. Showe Bxis Title

S Ads Title Properties. ..

O3
|
-
o]
=
-
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Figure 20: Turn Off the Horizontal Axis Title

The chart will look like the following figure:

E Drop datafields here
[Sum{SalesAmount)]
Ch i ]
Yearly Sales By Region [Orderyear]
100+ BN Order Year A
a0 4 Order Year B
= 60
m} W ]
T 404 Drop series fields
5] here
20~
0- - . .
Region A Region C Region E
Region B Region D Region F
o T ]
Drop category fields here
8 [Region] ExecutionTime]

Figure 21: Chart Design

12. To run your report, click the Home tab and click Run or press F5.

5$1,584,398.02 $5,793,102.73

e smwrien

Yearly Sales By Region
30000000+ I 2003
25000000 2004
20000000+
15000000 H
10000000

5000000 -
0 III_ ||

Europe
Morth Amenca Pacific

Sales (1k)

Figure 22: Previewing the chart

The result should resemble the chart above. Let's modify this chart further, and format the sales numbers on the
left X-Axis for currency.

To format the Sales numbers in the X Axis for currency, perform the following steps:

1. Switch back to design mode by clicking Design or press F8.
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Right-click the numbers of the sales at the X- Axis, then select Axis Properties....
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=

Show Axis Title

Charkt

" |
3
Show Bxis

Show Majar Gridlines

Shiow Minaor Gridlines

— ﬁ' Axis Properties. ..

To see the Axis Properties option, right-click on the Axis Title instead of the actual Axis Numbers.

|
I Axis Options . .
Set number formatting options.
Labels
Label Font Category:
Default sample
- Mumber '| Number 512,345
Curren
Major Tick Marks Percentage .
Scientific Decimal places:
Minar Tick Marks Custom
Use 1000 separator ()
Line

Show values in: [Thuusands V]

|:| Show zero as: -

Megative numbers:

Symbal:
| English (United States) -

|:| Show symbol after value

|:| Include a space

Current regional settings: English [United States)

| ok || cancel

Figure 23: Value Axis properties Dialog
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3. Inthe Value Axis Properties dialog box, select the Number pane and select the Currency category.

4. Set Decimal places to 0.
5. Select the Use 1000 separator check box.
6. Select the Show values in check box, then select Thousands from the drop-down list.
7. To run your report, click the Home tab, then click Run or press F5.
Note the X-Axis and the currency format.
Sales
By Region

Product Sub
Category Category

$15,897,306.98 $45,060,716.72 $7,220,537.93 $68,178,561.63

Yearly Sales By Region

I 2003
. 2004

$30,000 -
$25,000 -
520,000+
15,000+
10,000 -
55,000 -
50 -

Sales (1)

Europe
MNaorth Americe Pacific

Figure 24: Previewing the Completed Chart

l{  Save your report to the server: To save your report to the server, perform the following steps:

|
1. Click the Report Builder @ icon, then select Save As.
2. Select the My Reports folder, if present, on your local server.

3. Enter the file name ‘SalesbyRegion_ex4.rdl’.
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Chart Wizard and Styles

The Chart Wizard enables you to easily create charts. The Chart wizard includes a list of pre-defined chart styles
to select from, and it also guides you through creating data sets.

Mew Chart

Choose a style

Styles feature different fonts and color schernes, but do not affect the basic layout, Y ou can customize the style after vou finish the wizard,

Styles,

|C0rEDrate

Genetic Chart Title
Mahogany

Ocean £
Slate .

Preview

=HEBERE

Y= A Moot A
o |¥emA e B

=B -Momik A
Ml Y=E -3k B

Figure 25: Sample of the Chart Styles Found in the Chart Wizard
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Exercise 7: Enrich Your Data Visualization Using a Gauge

In this exercise, you will:

e Add a basic horizontal gauge to the Report you previously created.

The gauge adds a visual queue regarding the sum of sales amount per category, and the way they stack up
to a desired goal of 80 million.

Note

Remember the design time functionality to zoom in/out, which becomes more useful as your report gets
larger and more complex.

This exercise assumes that you have completed Exercise 6.

Adding a Horizontal Gauge to the Report

To complete this exercise, follow these steps:
1. Open the report SalesbyRegion_Ex6.rdl created previously.

2. To add a new column to the right edge of the Tablix, right-click the header and select Insert Column and
then click Right.

Note

If you do not see the headers, click anywhere in the Tablix.

Inzert Column 3 Left
_____ Delete Columns Right

Column Visibility...

[$12,34 ¢ Tablix Properties...

acuted: [&Execution Time]

Figure 26: Insert a New Column
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3. In the Insert ribbon, click Gauge and then click in the last cell of the newly added Total row of the
ProductCategory group.

Sales

Total

[$12,345.00]

[$12345.00] |[$12345.00] |[$12345.00]

[EPageNumber] of [&T otalPages] : : Executed: [&Execution Time]

Figure 27: Insert a Gauge into the new column on the Total row
The Select Gauge Type dialog appears.

4. Select the first Linear type, Horizontal, then click OK.

Figure 28: Select Gauge Type
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5. To adjust the size of the Tablix and Gauge, drag the row and column wider to view and to click on individual

elements within the gauge, such as the rectangular pointer and the scale of numbers.

The Tablix looks as below.

Product Catego Sub Catego JLGER =T

[SubCategory [$12,345.00]

Total

[$12,245.00] [$12,345.00] [$12,245.00]

[$12,345.00]

6. To add the Data field in the Guage, click the Field Selector Elinside the Gauge and select SalesAmount.

7. Click the Gauge so field area is visible, then click the LinearPointer area to see the field selector.

8. To set the Scale Properties, right-click the scale and select Scale Properties....

Figure 29: Resize Gauge

Drop datafields here
LinearF'-:uint

SubCategory
OrderYear
OrderQtr

ProductCategory

Salesfimount

Territory

Regicn

Drop datafields here

| [Sum{SalesAmount]] |

..................... =0

X Delete 5cale

Add Pointer
Add Range

Gauge

Show Labels
Show Major Tick Marks
Show Minor Tick Marks

@) (<] <] <]

Scale Properties...
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9. Inthe Linear Scale Properties dialog box, select the General category.
a. Set the Minimum scale to 1000000 (one million).

b. Setthe Maximum scale to 80000000 (eighty million).

| I | Change the value option for the scale
Action W
Layout [T] reverse scale direction
Labels
Font Value and interval options
Mumber Minimum: Magimum:
Major Tick Marks 1000p00 T 50000000 v

Interval: Interval offset:

Auto - Auto -

Multiply scale labels by:

Barder 1 z

Shadow

Minor Tick Marks

Fill

*

Logarithmic scale options

[7] Logarithmic scale

o J [ e

Figure 30: Linear Scale Properties—Setting the Min/Max
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10. Select the Number category, then do the following:

a.

In the Category list, select Currency.

b. Set Decimal places to 0.

C.

AD-HOC REPORTING

Select the Show values in check box, then select Millions from the drop down list.

Linear _Ei

General
Action
Layout

Labels

Major Tick Marks
Minor Tick Marks
Fill

Barder

Shadow

Set number formatting options.

Category:

Default
Mumber
Curren
Percentage
Scientific
Custom

Sample
512345

Decimal places:

[ use 1000 separator )

Show values in: [Miiiiuns "]

[ show zero as: B

Megative numbers:

513345
§-12345
§17345-

Symbolk
| English (United States) -

|:| Show symbol after value
|:| Include a space

Current regional settings: English (United States)

[ ok

] [ Cancel
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Figure 31: Currency Settings
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11. Click OK.

Total

[$12,345.00]

51 31 361 280
RN SR RN AR NN
I

[$12,345.00]

12. To run your report, click the Run tab or press F5.
The rendered report will look similar to the second figure.

Sa IeS by Region

Product Sub
Category Category

$15,897,306.98 $45,060,716.72| 5$7,220,537.93| $68,178,561.63

Figure 32: Previewing with the Gauge

The report now has the visual aid of the gauge to make it easy to understand the relative sales performance of
the different categories.

Take it one step further and, using an expression, alter the gauge so the gauge pointer color depends on the
sales amount itself. At this point, we should also make the pointers larger for better readability.
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1. Right-click the pointer, then select Pointer Properties.

3 =21 1 2]
|g|’9‘III Ppoenreerntfirneen |

Clear Pointer Value

)( Delete Pointer

Gauge *

' Pointer Properties...

AD-HOC REPORTING

2. In the Linear Pointer Properties dialog box, select the Pointer Options category. To enlarge the pointer for

easy viewing, do the following:

a. Setthe Width of the pointer to 15.

b. Set the Length of the pointer to 30.

Linear Pointer Properties

|'mtmm—'|
Action

Painter Fill

Painter Border

Shadow

Set pointer's type, style and placement options.

Value:

[Sum(5alesAmount]]

Pointer type and style options

Pointer type:

Marker -

barker style:

Wedge -

Placement and size options

Placement [relative to scale): Distance from scale:

Outside - |u

Width: Length:

15 H o

B2Gnow Support e support@b2gnow.com

Figure 33: Resizing the Pointer
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3. Select the Pointer Fill category and do the following:

a. Select the Solid option for Fill Style.

b. To select the color, click the function button lﬁ] at the Color drop-down list.

h- Pointer Options

Action

|_ Painter Fill

Pointer Border

Shadow

Set pointer background fill optiot

Fill style:
@ solid
() Gradient

() Pattern

Pick color

Colon

| white | [ A

Figure 34: Pointer Fill Style and Color
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To relate the color with the position of the guess, perform the following steps:
1. Inthe Expression dialog, enter a formula that supplies the following logic for pointer color:
Red: SalesAmount < five million.
Yellow: SalesAmount > five million but less than fifty million.
Green: SalesAmount > fifty million.
a. Delete the default ‘White’ entry.
b. Copy and paste the following formula into the expression editor.

=iif(Sum(Fields!SalesAmount.Value)<5000000,"red",iif(Sum(Fields!SalesAmount.Value)<50000000

,"yellow","green"))

2. Click OK.

| Set expression for: FillColor
=iif (Sum(Fields!SalesAmount . Value)< 5000000, "red " if (Sum{Fields! SalesAmourt . Value)<50000000, "yellow", "green"}|

Category: ftem: Values:
- Constarts [ No Color
- Built4n Fields
.- Parameters . . . . . . . .
. Fields {DataSet1) EEEEEEREEN
- Datasets EEEEERERE
- Varables OOONBECDNEO
4-Operators ENONOEEO
[+ Common Functions
EEEEEEER
Mare colors...
Help | oK || Cancdl

Figure 35: Expression Dialog
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3. Run your report: Go to the ‘Home’ tab, then click the ‘Run’ button or press F5.

Sa IeS by Region

Product Sub
Category Category

- oo
-- --[“71*}

I

R
.
.

$15,897,306.98| $45,060,716.72| $7,220,537.93| $68,178,561.63

Figure 36: Previewing the Completed Gauge with Colored Pointers

H  Save your report to the server: To save your report on the server, perform the following steps:

e
1. Click the Report Builder @ icon and then select Save As.
2. Select the My Reports folder, if present, on your local server.

3. Enter the file name ‘SalesbyRegion_Ex7.rdl’.
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Exercise 8: Modify the Tablix to Show Two Parallel Dynamic Groups

In this exercise, you will:

e Modify the Tablix report created in Exercise 3, and enhance its functionality.

e Enhance the functionality by moving the OrderYear sub-grouping to be displayed as a new adjacent column,
thereby enabling a second independent dynamic group within a single report item—something new for SQL
reporting Services 2008.

The group brace symbols are a visual indication of what we will be changing.
TO

[Region] | [Region] [OrderYear] |
RS Jrota! e

Another subtle hint is the spacing in the Grouping window, with Group1 no longer being indented.

T column Groups T0 i column Groups

[ Region ::> [ Region
[ Crderyear [ Groupl

e Remember you can ‘Undo’ actions using <CTRL>+<Z> or the Undo button in the Ribbon

=)

= -s H:.'-‘.“

4 "k-i-;:“;" == =
= e Run

This exercise assumes that you have completed Exercise 7. The images show the Gauge from Exercise 7
but is not required to complete this lesson—just the core Tablix.

Modifying the Tablix to Enhance Functionality

To modify the Tablix, perform the following steps:
1. Open the report SalesbyRegion_Ex7.rdl you previously created.
2. Delete the OrderYear sub group.

Delete this group to add it as a second grouping at the end of the matrix, and not as a sub-grouping within
the matrix.

3. Todo this, select the drop-down menu to the right of the OrderYear sub-group name '™ 'in the Grouping
window, thenselect Delete Group.
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ﬂm] Column Groups -
[ Region -
[ Crderyear -
Add Group k
Add Total |
|)( Delete Group |I
'  Group Properties...

Figure 37: Delete OrderYear group

4. Select Delete group and related rows and columns in the Delete Group dialog box.

Delete group options:

@ Delete group and related rows and columns

(71 Delete group only

Your Tablix will now resemble the following figure.

Total
[$12,345.00]
T |

|$il 531 s61 %80 |i
]
|

\ |‘||1|'||l|'||||'||||||'||

J

[$12,345.00] [$12,345.00]

Figure 38: OrderYear Group Deleted

5. To add an adjacent group after Region, right-click the grouping window, select Add Group, then select

Adjacent After.
T Column Groups o
[ Region -
| Add Group * | Parent Group...
Add Total | » Child Group...
X Delete Group Adjacent Before...
@ Group Properties... | Adjacent After...

Figure 39: Add Adjacent Group
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6. Click OK.
7. Select Group By [OrderYear] in the Tablix group dialog box.

8. Right-click in the new [OrderYear] column and add SalesAmount.

Note

SalesAmount is added to the whole column.

ProductCategory
SubCateqaory
Crder'fear
OrderQty

Tetritary
Reqgion

Total
[$12,345.00]

R )

51 21 361 580
) Jorgornrerdornrerene oo
e |
\ J

[$12,345.00] | [Sum(SalesAn [$12,345.00]

Figure 40: New Adjacent group

Note

The two group brace symbols are now alongside each other on the column headings.

B2Gnow Support e support@b2gnow.com 9-59




BZGNOW AD-HOC REPORTING

Note.

Changed from

5 Orderyear]

[5um(5aleaﬁ mount,

[$12,345.00] [Sum(SalesAn

[Sum{SalesAmour| [Sum(SalesAmount

9. Set all three [Sum (SalesAmount)] cells in *>=~new [OrderYear] column to currency format by clicking each
cell and using the currency button on the Ribbon.

10. To add total columns for each of the two column groups using the grouping window, select Add Total in the
drop-down for Region, then select After. Repeat this step for the new group.

I Region

Regon o~ [_ ]

fGowpr | AddGroup »
| AddTotal v |

Delete Group

X
¥ Group Properties...

Your Tablix will now resemble the following figure.

Total

[$12,345.00]

B 321 361 380
O AR
N

[$12,345.00] [$12,345.00] [$12,345.00] [$12,345.00] [$12,345.00]
Figure 41: Design View of the Completed Tablix, with Parallel Dynamic Groups

11. To run your report, click the Home tab and click Run or press F5.

3 361 580
‘IllllllllllllllIIlI|IIlIiI\

IR R
O 200

$15,897,306.98 $45,060,716.72 §7,220,537.93 $68,178,561.63| $42,308,575.23| §25,869,986.41| $68,178,561.63| $68,178,561.63
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Figure 42: Previewing the Completed Tablix with Parallel Dynamic Groups
I Save your report to the server: To save your report on the server, perform the following steps:
=
: . -l
1. Click the Report Builder —rt icon, then select Save As.
2. Select the My Reports folder, if present, on your local server.

3. Enter the file name SalesbyRegion_Ex8.rdlI.
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Exercise 9: Manual Creation of a Tablix to Match Exercise 3 (Wizard

Tablix)

In this exercise, you will:

Manually create a Tablix—similar to what you used the Matrix wizard for in Exercise 2.

This exercise assumes that you have completed Exercise 3. You can also build this on top of later
exercises, though your images will look different (with more objects). Alternatively, you can create new
report and repeat Exercise 3 again.

Manually Creating a Tablix Similar to Matrix Wizard

To manually create a Tablix similar to Tablix in Matrix wizard, we use the report created in Exercise 2,

SalesbyRegion_Ex3.rdl. While this exercise creates a new report, using the report from Exercise 2 will enable

you to compare the two versions. After opening the report, follow these steps:

1.
2.
3.

5.

9-62

Insert a new tablix below the existing one.

Create some blank space below the existing Tablix.

From the Insert tab of the Ribbon, select Matrix, then select Insert Matrix.
Resize the new matrix below the existing one.

Your report in design mode will look similar to the following figure.

Click to add title

(Regon
Product  Sub [OrderYear] Total ]
[ProductCates [SuhCat&gory [Sum(Salesamc [Sl.ln(SaImAn
[Sum(SalesAn [Sum(SalesAn [Sum(SalesAn

ﬁﬁ!llllIIIIIIIIIIIIIIIIIIIIIIIIIIII

[&ExecutionTime]

Figure 43: Empty New Tablix
From the Report Data window, do the following:

a. Drag the Region field to the Column Groups area of the Grouping window.
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b. Dragthe OrderYear to the Column Groups area of the Grouping window below Region.

Note

[Orderyear] is automatically made a child of Region and is indented.

j Column Groups

[ Regionl
[ Crderyearl
6. From the Report Data window, do the following:
a. Drag the ProductCategory field to the Row Groups area of the Grouping window.

b. Drag the SubCategory field to the Row Groups area of the Grouping window, below
ProductCategory.

= Row Groups

[ ProductCategoryl
[ SubCategoryl

7. From the Report Data window, drag SalesAmount to the Data cell at lower right of the Tablix. The new
Tablix will look similar to the following figure.

| | |

Eg[Reginn]

Product Category Sub Categary Eg[Drder‘r‘ear]

[[ [FroductCategory] [ZubCategory] f=umiSalesimount)]

|

8. To add the totals after all of the groups in the grouping window, click each of the four groups, select Add
total, then select After.

=] Row Groups j Column Groups
[ ProductCategaryl - || [ Regionl
[ SubCategoryl Add Group ' I
| Add Total | v | Befare
X Delete Group | After |‘
“F  Group Properties... |

The new Tablix will resemble the following figure.
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I
| §|§[Reginn] l |Tnta|
- |Product Categary Sub Categary Eé[Drder‘r‘ear] Tatal
([ [iProductCategory]  [SubCategory]  [Sum(SalesAmount)]  [Sum(SalesAmi [SumiSalesAm:
% Tatal EE[Sum[SalesAmuuntJ] [BumisalesAm [Sumizalesim
| Total EE[Sum[SalesAmuuntJ] [Bumizalessm || Eiul el

9. To run your report, click the Home tab and click Run or press F5.

Note

The data is grouped as desired, but it is difficult to initially view and understand it, as there is plenty of

information. Hide the sub groups for the initial preview, just like the wizard did. Click the Design Tab or press
F8 to switch back to Design mode.

10. To hide the subgroups but allow the user to toggle them on, select Group Properties for Subcategoryl from
the Grouping Window.

[ ProductCategoryl « || [ Regionl
[ subCategoryl - [ Crderyearl
Add Group 3
Add Tetal | »

7 Delete Group

|f]"‘ Group Properties... |

11. In the Group Properties dialog box, select the Visibility category.

a. Set When the report is initially run to Hide option.

b. Select the Display can be toggled by this report item check box, then select ProductCategoryl.

Note

The 1is important as in the list where ProductCategoryl AND ProductCategory both appear, and
ProductCategory is the instance from the first Tablix.

c. Click OK.
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[roup Properie: ]

General

i Change display options.
| | Page Breaks
sorting When the report is initially run:
[' Visibility ] ) Show
@ Hi
Filters ? Hide
) Show or hide based on an expression
Wariables
b
Advanced
Display can be toggled by this report item:
[ ProductCategoryl - ]

[ oK J [ Cancel

Figure 44: Group Properties setting the toggle item.
12. Repeat the same changes to the OrderYearl subgroup:
a. From the Grouping Window, select Group Properties for OrderYearl.
b. From the Group Properties dialog, select the ‘Visibility’ page
c. Set When the report is initially run to Hide.

d. Select the Display can be toggled by this report item check box and select Regionl from the drop-
down list

Note

The 1 is important as in the list where Regionl AND Region both appear, and Region is the instance from the
first Tablix.

e. Click OK

13. To run your report, click the Home tab and click the Run or press F5.

Note

Other than a few formatting properties such as colors and size, the two Tablix report items are the same.
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Product Sub Category

15897306.9833 45060716.7241 7220537.9250 68178561.6324

Europe Morth Pacific Total
America

Product Category Sub Category1 Total Total Total

Accessories Total 320970.8725  681088.9944 1626645486 1164724 4155
Bikes Total 13636198 4470 37438536.6641 6740590.7604 57B815325.8715
Clothing Total 3557396391 1147988.3374  113491.5624 1617219.5389
Components Total 1684398.0247 67931027282  203791.0536 7581291.8065
Total 15897306.9833 45060716.7241 7220537 9250 68178561.6324

Figure 45: Completed Tablix.

I Save your report to the server: To save your report on the server, perform the following steps:

|
1. Click the Report Builder @ icon, then select Save As.
2. Select the My Reports folder, if present, on your local server.

3. Enter the file name SalesbyRegion_ex8.rdlI.
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Exercise 10: Use Query, Parameter, and Filter to Limit the Tablix
Data

In this exercise, you will:

e Create a new dataset that will return a unique list of the sales regions.

e C(Create a parameter that will use the new dataset, and will present the user the values to select from when
the report is run.

e Create a filter on the tablix, which will use the value(s) the user selects from the parameter to filter/limit the
data that is actually shown in the tablix after running when the report.

Filters are very useful for many scenarios such as including a single dataset for the report, but you can also
represent different subsets of the data using multiple data regions (e.g. chart or tablix).

New dataset/query to build list | Parameter uses the new dataset to Tablix filter uses the selections
of possible regions present the list of possible regions to made in the parameter to filer/limit
the user when they run the report the data the tablix shows.
I—|/ I—|/

This exercise assumes that you have completed Exercise 3. You can also build this on top of later
exercises, though your images will look different (with more objects). Alternatively, create new report and
repeat Exercise 3 again.

Creating a New Data Set to Return a Unique List of Sales Regions

In these steps we will create a new data set, or query to a list of regions. We will then use this region list to
enable users to select what regions to filter.

To complete this task, follow these steps:

1. Open the report “SalesbyRegion_Ex3.rdl” previously created in Exercise3. If you do not have it, rerun the
wizard (Exercise3).
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2. Inthe Report Data window, right-click the Data Source and select Add Dataset.

Report Data ‘
Mew - Edit.. ~ J
[~ Built-in Fields
1_'} Parameters - (
1__] Images

o Datl Add Dataset.. |

Delete

Data Source Properties
P

H-; | Figure 46: Adding a Dataset
3. Inthe Dataset Properties dialog box, select the Query category, and do the following:
a. Click Add to add a filter.
b. Enter Name as regionlist.
c. Set Data Source to LocalAdventureWorks (or whatever you have named your datasource)
d. Select the Text option for Query Type and enter the following query string in the Query field

Select Distinct Sales.SalesTerritory.Group AS Region from
sales.SalesTerritory

Dataset Properties ==

Query Choose a data source and create a query.

Parameters
Fields Name:

Options regionlist

Filters Data source:

LocalAdventureWorks '] [ New...

Query type:
@ Text Table (O) Stored Procedure
Querny

select distinct Sales.SalesTerritory.[Group] AS Region from -
sales.5alesTerritory

Query Designer... ] [lmport... ] [Befresh Fields...

Time out (in seconds):
0 =

-

Coc [ o )

Figure 47: Create New Query To Use Source The Parameter List

4. Click OK

Creating a Parameter
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1. Inthe Report Data window, right-click Parameter, then select Add Parameter.

2. Inthe Report Parameters dialog box, select the General category, then do the following:

a. Click Add to add a filter.

Report Data

Mew - Edit.. & 4 ]

-1 Built-in Fields

- Pammete
[ Images Add Paramet

E|_-__=b LocalfdventureWorks
- DataSetl
E|:| regicnlist
=] Region

Figure 48: Create a New Parameter

b. Enter Name as whatregions.

c. Enter Prompt as whatregions.

d. Select Data type as Text, then select the Allow Multiple Values check box.

e. Select the Visible option for Select parameter visibility.

Report Parameter Properties

General

Advanced

Available Values

Drefault Values

Hame:

whatregions

Prompt:

whatregions

Data type:

[Text -

[ Allow blank value [
|:| Allow null value
Allow multiple values

Select parameter visibility:
@ Visible
(") Hidden

) Internal

Change name, data type, and other options.
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Figure 49: Parameter General Settings
3. Select the Available Values category, then do the following:
a. Select Get Values from query option.
b. Select the Dataset as regionlist.
c. Select Value field as Region.
d. Select Label Field to Regionv

4. Select Allow Multiple Values category.

o

Report Parameter Properties [5]

General B .
Choose the available values for this parameter.

Available Values ]

Default Values Select from one of the following options:
Advanced ) None
71 Specify values

@ Getvalues from a query

Dataset:

[reginnlist v]
Yalue field:

[Reginn v]
Label field:

[Reginn ']

OK l [ Cancel

Figure 50: Parameter Available Values Settings.

You should now see your parameter, as well as the new dataset listed in the Report Data window.
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Report Data
New - Edit.. & =+ ©

-4 Built-in Fields
[ Parameters

-] DataSetl
=1~ regionlist
...[=] Region -

Figure 51: New Parameter and Data Set Listed in Report Data Window

Create the Tablix FilterThe filter in Tablix enables the user to dynamically select different region(s) to filter on
each time they run the report. The user can then export the different views and, in effect, create a form of ad

hoc query functionality.

To create a filter in Tablix, perform the following steps:

1. Select the top edge of the Tablix, right-click it, and select Tablix Properties.
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#¢  Tablix Properties...

Figure 52: Open Tablix Properties
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2. Inthe Tablix Properties dialog box, select the Filters category, then do the following:

9-72

a. Click Add to add a filter.
b. Set Expression to [Region] .
c. Set Operator to IN.

d. Set Value to [@whatregions] .

AD-HOC REPORTING

Tablix Properties

General )
Change filters.
Visibility
[~ Fiters | Delete || & || &
Sorting

Expression [Region]

Cperator [In

Value [Ewhatregions]

- Text

OK ] [ Cancel

Figure 53: Tablix Filter Settings

3. Click OK.

You are now ready to run your report, and select the region from the parameter area.

1. Torun the report, click the Home tab, then click the Run button or press F5.

2. Select Europe, then click the View Report on the right.
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|

whatregions [ - ]

(Select All)

Morth Armerica
Pacific

Figure 54: Selecting Parameter Values
Your report will look similar to the following figure, which only shows the Europe group.

3. Switch back to the Design view.

Product Category  Sub Category

$15,897,306.98| $15,897,306.98

Figure 55: Tablix with the Filter Applied

4. Change your filtering by simply selecting different parameters and clicking View Report. Repeat this a few
times and view the results.

lH  Save your report to the server: To save your report on the server, perform the following steps:

-
1. Click the Report Builder icon @, then select Save As.
2. Select the My Reports folder, if present, on your local server.

3. Enter the file name SalesbyRegion_ex9.rdI.
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For more information, reference the following SQL Server 2008 Online topics:
Filter Equation Examples (Reporting Services)
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References and Where to Get Help

SQL Server Reporting Services home page:
http://msdn.microsoft.com/en-us/sqlserver/default.aspx

SQL Server 2008 Reporting Services on Microsoft TechNet:
http://technet.microsoft.com/en-us/library/ms166352.aspx

SQL Server Reporting Services Forum:

A great place to ask questions to the larger community, as well as see what others are asking and answering.

http://forums.microsoft.com/Forums/ShowForum.aspx?ForumID=82&SitelD=1

SQL Server 2008 Reporting Services Books Online (Help):
http://msdn.microsoft.com/en-us/library/ms159106(SQL.100).aspx

www.codeplex.com for Adventureworks sample database and report downloads:

http://www.codeplex.com/MSFTDBProdSamples/Release/ProjectReleases.aspx?Released=18407

Main SQL Server samples page:

http://codeplex.com/SqlServerSamples

Microsoft Connect Feedback site:

http://connect.microsoft.com

A connection point between you and Microsoft, and ultimately the larger user community. Your feedback
enables Microsoft to make software and services the best that they can be, and you can learn about and
contribute to exciting projects.
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